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IMPORTANT NOTICE - PLEASE READ FIRST
THIS SOFTWARE IS USED AT YOUR OWN RISK. IMPROPER USE OF THIS SOFTWARE MAY 
RESULT IN IMPROPER FUNCTIONING OF A MODULE. THE USER IS SOLELY RESPONSIBLE FOR 
THE RESULTS OF ANY USE OF THE SOFTWARE. HED MAKES NO REPRESENTATIONS OR 
WARRANTIES OF ANY KIND, EXPRESS OR IMPLIED, WITH REGARD TO THE SOFTWARE, ITS 
USE, OR ANY RESULT THAT MAY BE OBTAINED THROUGH ITS USE. USE OF THE SOFTWARE 
REQUIRES PROFESSIONAL JUDGMENT AND IT IS SOLELY THE USER'S RESPONSIBILITY TO 
ASSESS THE APPROPRIATENESS OF ANY APPLICATION OF THE SOFTWARE. HED WILL NOT 
BE LIABLE TO THE USER OR ANY THIRD PARTY FOR ANY DAMAGES OF ANY KIND, DIRECT, 
CONSEQUENTIAL OR OTHERWISE, REGARDLESS OF THE LEGAL THEORY, ARISING FROM OR 
ASSOCIATED WITH THE SOFTWARE OR ITS USE.

DISCLAIMER OF WARRANTY. The Software is provided on an "AS IS" basis, without warranty of any 
kind, including, without limitation, the warranties of merchantability, fitness for a particular purpose and 
non infringement. The entire risk as to the quality and performance of the Software is borne by You. 
Should the Software prove defective, You, not Vendor or its licensors, assume the entire cost of any 
service and repair. If the Software is intended to link to, extract content from or otherwise integrate with a 
third party service, Vendor makes no representation or warranty that Your particular use of the Software 
is or will continue to be authorized by law in Your jurisdiction or that the third party service will continue to 
be available to You. This disclaimer of warranty constitutes an essential part of the agreement. VENDOR 
HEREBY EXPRESSLY DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, TITLE, 
NONINFRINGEMENT AND FITNESS FOR A PARTICULAR PURPOSE.

LIMITATION OF LIABILITY. UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, 
TORT, CONTRACT, OR OTHERWISE, SHALL VENDOR OR ITS LICENSORS BE LIABLE TO YOU 
OR ANY OTHER PERSON FOR (AND VENDOR HEREBY EXPRESSLY DISCLAIMS ANY AND ALL 
LIABILITY FOR) ANY INDIRECT, SPECIAL, PUNITIVE, INCIDENTAL, OR CONSEQUENTIAL 
DAMAGES OF ANY CHARACTER INCLUDING, WITHOUT LIMITATION, DAMAGES FOR WORK 
STOPPAGE, COMPUTER FAILURE OR LOSS OF REVENUES, PROFITS, GOODWILL, USE, DATA 
OR OTHER INTANGIBLE OR ECONOMIC LOSSES. IN NO EVENT WILL VENDOR OR ITS 
LICENSORS BE LIABLE FOR ANY DAMAGES IN EXCESS OF THE AMOUNT PAID TO LICENSE 
THE SOFTWARE, EVEN IF YOU OR ANY OTHER PARTY SHALL HAVE INFORMED VENDOR OR 
ITS LICENSORS OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM. NO CLAIM, 
REGARDLESS OF FORM, MAY BE MADE OR ACTION BROUGHT BY YOU MORE THAN ONE (1) 
YEAR AFTER THE BASIS FOR THE CLAIM BECOMES KNOWN TO THE PARTY ASSERTING IT. 

INDEMNIFICATION. You and Your agents will indemnify and hold harmless Vendor and its officers, 
directors, shareholders, employees, agents, successors, assigns and affiliates from and against any 
award of costs or damages brought against Vendor to the extent that such award is (i) based on a claim 
regarding the use, installation or configuration of Software by You or Your agents; or (ii) based on a claim 
regarding modification, translation, customization or localization to the Software by You or Your agents. 
Vendor shall indemnify and hold You harmless against liability to third parties (only for liability solely the 
fault of Vendor) to the extent arising from the violation of any third party's copyright rights in connection 
with the use by You of the Software (a) as delivered by Vendor to You and (b) in accordance with this 
License Agreement, provided that (i) Vendor shall have the right to conduct any defense and/or 
settlement in any such third party action arising as described herein, (ii) You shall fully cooperate with 
such defense, and (iii) Vendor receives prompt written notice from You. In no event shall You settle any 
such claim, lawsuit, or proceeding without Vendor's prior approval, and Vendor shall have no liability for 
any such unapproved settlement so made. This indemnification is limited to the Software delivered to 
You or as modified by Vendor and does not cover third party claims arising from modifications to or uses 
of the Software in a manner not authorized by Vendor.

FULL TEXT OF THE CANLink® Downloader™ LICENSE IS INCLUDED WITH THE SOFTWARE
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GENERAL INFORMATIONSoftware Installation
General Information

SOFTWARE INSTALLATION
Refer to the CANLink® Orchestra™ Software Installation Manual for system requirements 
and for procedures on how to install the CANLink Downloader software.
1



GENERAL INFORMATION Main Window
MAIN WINDOW

Figure 1

Program Menu

(A) File
Use this menu to connect to the Master Module, select Comm Port, or Exit the 
application.

(B) Match
Use this menu to change how modules are grouped in the display after connecting.

(C) Help
About the Downloader

Tool Bar Buttons

(D)  Connect
Use this button to connect to the Master Module.

Status Bar

(E) Progress Bar
Displayed during Connect and Module Query only.

(F) Comm Port
Displays current port number selected.

(G) Serial Communication Parameters
Displays baud rate, parity, bits per byte, stop bits.
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QUICK STARTGeneral Information
Quick Start

GENERAL INFORMATION
The Downloader transfers Program Files from the connected computer into CANLink 
modules that are connected via USB, RS-232 or modem connections. After the initial 
install, the Downloader defaults to use COM1 port. Change the port under the File menu 
option Connect Using… (see Changing the Port on page 5). When the port is changed, 
the Downloader saves setting as the default to use the next time the Downloader runs.

When the Downloader connects, it enters either of two modes, depending upon the 
Master Module firmware. If the Master Module supports module version reporting then 
the Downloader enters Module Versions Mode; otherwise it will enter the Legacy Mode. 

In Module Versions Mode the Downloader displays a list of known modules and versions. 
The user may select any or all of them and then initiate download. The Downloader 
determines which Program Files to send by using its database of module types. 

In Legacy Mode the user works with one module type at a time. The user selects which 
Program File to download to a module type that is also entered by the user.

Quick Start - Module Versions Mode
The download procedure is simple, requiring a few key strokes or mouse clicks, as 
follows:

1. Click the  Connect button to establish communication with the Master Module.

2. Choose which module(s) to program.

3. Click the  Start button.

Figure 1

Select any or all of the modules that are connected to the Master Module. Press Start and 
the Downloader does the rest. The Downloader uses its predefined database to 
determine which application file should be sent to each Module Type and automatically 
downloads the appropriate code.
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QUICK START General Information
Quick Start - Legacy Mode
If the Master Module has older firmware that does not report module types and versions, 
then the Downloader connects in Legacy Mode. In Legacy Mode, the user must specify 
which file to download for each Module Type.

Note: Module Type is a four-digit hexadecimal value that the OEM supplier can 
provide. The Master Module is always identified as Module Type: FFFF.

Here are the steps to download in Legacy Mode:

1. Click the  Connect button to establish communication with the Master Module.

2. Use the Downloader’s File>Select File dialog box or Select File file history dropdown 
list to identify the path and filename of the Program File to download.

3. Enter the 4-digit Module Type of the module(s) that should receive the code from the 
selected file (FFFF for the Master Module).

4. Click the  Start button.

Figure 2

If the Downloader connects in Legacy Mode, then consider first upgrading the Master 
Module with the latest firmware. Thereafter, any updates to the remaining modules will 
use the three-step procedure outlined in Quick Start - Module Versions Mode on page 3.

3
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QUICK STARTGeneral Information
Changing the Port

Figure 3

Before connecting, configure the Downloader to use the appropriate port. The port can be 
configured from the File menu. Select Connect Using... to see the Connect Using 
window that lists the connection options. The following is a detailed description of the 
Connect Using window.

Port Type
In the upper part of the window are located two option buttons (Figure 3, A) that specify 
whether the computer is connected locally through a USB/RS-2321 port or remotely 
through a Modem. If the Modem option is chosen, then a Phone Number dropdown list 
(Figure 3, B) appears below the Port Type option buttons. In the Phone Number 
dropdown list enter or select a telephone number to dial. When a new number is entered, 
the Downloader stores the number and adds it to the dropdown list. The Port Type 
selection and the last number used will become the defaults for the next time the 
Downloader is used.

Port Selection
In the lower part of the window is the Port Selection list (Figure 3, C), which will specify 
which port is connected to the Master Module. The Port Selection list displays an option 
button (Figure 3, D) for each serial port on the connected computer. The buttons are 
labeled as COM<number> and device name. For example: COM1 Serial0. If a port is 
currently open (for instance, by another application) then its corresponding button is 
displayed in the disabled state.

The Port Selection list gets updated dynamically. If a USB connector or other such 
removable serial port connector is connected or disconnected from a module, the change 
shows up immediately in the Port Selection list. Press the Refresh Ports button to refresh 
the list.

Press OK to save the change(s) and close the Connect Using window, or press Cancel 
to close and return to the original settings. If using a modem, the Downloader does not 
dial until Connect is pressed on the Main window.

1 If using a USB connection, install a driver that emulates an RS-232 port. Contact the 
OEM supplier of the module to obtain the appropriate driver.

A
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QUICK START General Information
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MODULE VERSIONS MODEOverview
Module Versions Mode

OVERVIEW
When the  Connect button is pressed, the Downloader establishes communication 
with the Master Module and requests version details about all the modules. When the 
Master Module responds to the request, the Downloader organizes the modules 
according to their types and versions and displays them on the screen in groups. Within 
each group the modules are sorted by harness code.

Figure 1

Program Menu

(A) File
Use this menu to close the connection with the Master Module, or exit the application.

(B) Edit
Use this menu to Select/Deselect All listed modules at once, Start or Stop downloads, or 
Re-query Modules and refresh the display.

(C) Match
Use this menu to change how modules are grouped in the display for receiving 
downloaded code.

(D) Help
About the Downloader
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MODULE VERSIONS MODE Overview
Tool Bar

(E)  Disconnect
Use this button to close the connection with the Master Module and return to the Main 
window.

(F)  Select/Deselect All
Use this button to select or deselect all listed modules.

(G)  Start
Use this button to start the download.

(H)  Stop
Use this button to stop the download before completion.

(I) Module Versions List
Displays modules connected to the Master Module. Modules are grouped by Module 
Type, Hardware and Software versions.

(J) Icon Legend
Clarifies meaning of icons shown next to modules.

General Version Format
Within the Module Versions list, the Downloader displays versions in a general format. 
The general version format is HW.MJR.MNR, where the definitions of its subfields are:

HW = Hardware Version

MJR = Software Major Version

MNR = Software Minor Version

For example: 01.002.020 would indicate Hardware Version 01, Software Major Version 
002, and Software Minor Version 020.
8



MODULE VERSIONS MODEProgram Menu
PROGRAM MENU

File Menu
The File Menu is used to open or close the connection with the Master Module, or exit the 
application.

Note: With this release of the Downloader software, the Connect Using..., Select 
File and Reset File History menu choices are not active features at this time 
and will remain grayed out.

Edit Menu
The Edit Menu is used to Select/Deselect All listed modules at once, Start or Stop 
downloads, or Re-query Modules and refresh the display.

Match Menu (Advanced Topic)
Use this menu to change how modules are grouped in the display for receiving 
downloaded code.

The displayed grouping of modules is based on matching all such modules that have the 
same Module Type, Hardware Version, and Software Major Version. The Downloader 
provides a means to change the grouping by overriding version matching criteria. This 
may need to be done in order to accommodate unusual circumstances. For instance, 
should the OEM supplier recommend upgrading older modules having a lower Software 
Major Version to the latest Software Major Version, you will need to override Software 
Major Version matching. Do this using the Match menu to tell the Downloader to ignore 
Software Major Version when assigning the groups.

The Match menu has the following options:

Module Type, Hardware, Major, Minor < Latest
This is the installation default setting. Under this option all modules having the same 
Module Type, Hardware Version and Software Major Version shall be grouped together. 
Modules that have Software Minor Version less than the latest (i.e., highest) Software 
Minor Version found in the database for that group are selectable for download. Those 
with Software Minor Version equal to or greater than the latest are not selectable.

Module Type, Hardware, Major
This selection groups all modules having the same Module Type, Hardware Version and 
Software Major Version. No restriction is imposed upon Software Minor Version. This 
option effectively overrides Software Minor Version, thereby allowing downloads to 
modules that are already up-to-date or that have a higher Software Minor Revision than 
the latest revision found in the database for the group.

Module Type, Hardware
Groups all modules having the same Module Type and Hardware Version. Downloads the 
highest Software Major and Minor Version found for the given Hardware Version of that 
Module Type, overriding all software versions.

Module Type
Groups all modules having the same Module Type, without regard to Hardware or 
Software versions. Downloads the highest Software Major and Minor Version found for 
the given Module Type, regardless of Hardware Version.
9



MODULE VERSIONS MODE Program Menu
To override the Software Major Version click Match, and then select Module Type, 
Hardware. Under this Match option, Software Major Version and Software Minor Version 
will be ignored. All modules having the same Module Type and same Hardware Version 
will be grouped together, regardless of Software Major Version or Software Minor Version. 
When this group is selected for download, all modules in the group will be designated to 
receive the same code. The code to be downloaded would have the highest Software 
Major Version or Software Minor Version found in the database for the given Module Type 
and Hardware Version.

The Downloader saves the Match setting to be used as the default the next time the 
Downloader runs.

Note: The last option in the Match menu, “Module 
Type,” is a special case that requires a 
password (Figure 2) from the OEM supplier 
because of the potential for harm in loading 
the wrong firmware. The Downloader 
disallows using “Module Type” as a default 
setting for the next time the Downloader is run 
and instead reverts to the installation default, 
“Module Type, Hardware, Major, Minor 
< Latest.”

Figure 2

Help Menu
The Help Menu will display information about the Downloader software such as software 
version. This menu will automatically disappear after three to five seconds of display.
10



MODULE VERSIONS MODEModule Versions List
MODULE VERSIONS LIST
The items in the Module Versions list include two types: Group headers and module 
entries. They are formatted as follows:

Group Headers
Group headers are shown in bold type. A group header appears above the group of 
module entries that it represents. The format of the group header includes the following 
information:

<Module Type Name> – <Matching Version> (Latest <Latest Version>)

For example: “CL-103-101 – 00.001.*** (Latest 00.001.020).”

Where:

CL-103-101 = Module Type Name

00.001.*** = Matching Version

00.001.020 = Latest Version in the database for those modules

The Matching Version reflects the Match setting. In this case it shows that the modules 
having the same Hardware Version (00) and the same Software Major Version (001) shall 
be included in this group, and that the Software Minor Version is wild-carded to permit any 
value. The Latest Version shows the final general version that all the selectable modules 
in this group should reflect after programming.

Module Entries
Module entries appear in normal type unless the group is selected for download. The 
entries are shown in bold type when selected. The format of the module entries includes 
the following information: 

Harness <Harness Code>  Version <Hardware>.<Software Major>.<Software Minor>  <Status>

For example: “Harness 00  Version 00.001.001  Running.”

Module Status
The example (Figure 1) shows that the module status is Running. A module can have 
one of three states reported in the Status field:

• Running - The module is connected and active.

• Missing - The module is not communicating with the Master Module.

• Unexpected - This is an extra module that the Master Module detected.
11



MODULE VERSIONS MODE Module Versions List
Module Selection
Use either the mouse or the keyboard to select modules in the displayed list.

Selection by Mouse
If using the mouse, then click on any module entry or the module group title. Regardless 
of whether selecting a module or module group title, all modules in that group will become 
selected.

Selection by Keyboard
If using the keyboard, move the selection highlighting up and down by using the Up/Down 
arrow keys, and use the Enter key to select. When using the keyboard arrows, the 
highlighting jumps from one module group title to the next, skipping the individual module 
entries for faster scrolling.

Select All Button
• When all modules are selected (i.e., marked for download), the Select All button 

deselects all modules.

• Otherwise, the Select All button selects all modules.
12



MODULE VERSIONS MODEModule Versions List
Icon Legend
Next to each item in the Module Versions control, the Downloader displays an icon that 
indicates the status of the item. Below the Module Versions control is an icon legend for 
quick reference to understand their meanings. Here is a detailed description of the icons:

•  “Busy” - Appears next to a module group item after Start is pressed. Indicates that 
the Downloader is actively downloading to that module group.

•  “Downloading” - Appears next to modules after Start is pressed. Indicates which 
modules are currently receiving the download.

•  “Unknown” - Indicates that the module was not found in the database. Contact the 
OEM supplier for an update to the database and firmware files.

•  “Missing” - Indicates that the Master Module expected to find the module on the 
network but it is missing or not responding.

•  “Download Fail” - Attempted download failed, leaving the module in an uncertain 
state. To troubleshoot, check physical connections, check harness codes, cycle 
module power, and try again.

•  “Needs Update” - The module has a lower version than the version found in the 
database. It is selectable to mark for download.

•  “Up to Date” - The Module Version matches the version found in the database. 
Though its group may be selected, the module shall not be designated for download 
unless the Match criteria selection excludes Software Minor Version.

•  “Version High (N/A)” - Module Version is higher than that found in the database. 
Though its parent group may be selected, the specific module shall not be designated 
for download unless you override whichever version element is too high by using the 
Match criteria.

•  “Version High (OVR)” - Module Version is higher than in the database. The Match 
setting is overriding the version restraint so that the module shall be marked for 
download anyway if selected.

•  “Marked for Download” - Module is selected and designated to receive update 
when download begins.
13



LEGACY MODE Overview
Legacy Mode

OVERVIEW
The Downloader enters into Legacy Mode when connected to a Master Module having 
older firmware that does not report module types and versions. In Legacy Mode, manually 
locate and select the application file to download, and then enter which Module Type is to 
receive the file. Module Type is a four-digit hexadecimal value that OEM supplier can 
provide. The Master Module is always identified as Module Type: FFFF.

If the Downloader is in Legacy Mode, and the firmware in all modules is being upgraded, 
upgrade the Master Module first. Thereafter, all remaining modules will be able to be 
connected and downloaded from the Module Versions screen, which provides automatic 
file selection and Module Type entry. This approach is useful if all the Module Type codes 
for your modules are not readily available because only the Master Module Type code 
(FFFF) is required.

Figure 1

Program Menu

(A) File
Use this menu to disconnect, select the file to download, clear the history of selected files, 
or exit the application.

(B) Edit
Use this menu to Start or Stop downloads.

(C) Help
About the Downloader
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LEGACY MODEOverview
Tool Bar

(D)  Disconnect
Use this button to close the connection with the Master Module.

(E)  Start
Enabled after both File and Module Type are filled in. Use this button to start the 
download.

(F)  Stop
Enabled during download. Use this button to stop the download before completion.

(G) Select File (Ctrl+F)
Use this to select the path and name of the file to download.

(H) Select Stub 1
Enabled during download if the module requires a Stub 1 file.

(I) Select Stub 2
Enabled during download if the module requires a Stub 2 file.

(J) Module Type (See Module Type on page 16)

(K) Check Version Number (See Check Version Number on page 16)

(L) Version Number (See Version Number on page 16)

(M) Module Type Status (See Module Type Status on page 16)

Select File
To set up Legacy Mode for download, first select the appropriate file to be downloaded for 
the intended Module Type. The Downloader provides two ways to specify which file to 
send. Use the File dialog to locate the file on disk, or use the dropdown list to choose from 
a list of previously entered files. The File dialog can be opened by choosing Select File 
from the File menu or by clicking on the folder button located to the right of the Select File 
dropdown list.

When Select File is changed, the Downloader clears the Module Type to help prevent 
mistakes.

Select Stub 1 and Stub 2
The Select Stub 1 and Select Stub 2 dropdown lists are disabled until the Downloader 
determines that a stub code is needed during the download (after Start is pressed). If 
stub code is needed, then the Downloader enables the appropriate dropdown list, 
prompts for the file, and then confirms the filename before proceeding.

Reset File History
Every new file that is selected from the File dialog for Select File, Select Stub 1 or Select 
Stub 2 is added to its associated dropdown list for easier selection next time. If the Legacy 
Mode dropdown list contains too many obsolete entries, select the File menu option, 
Reset File History, to clear all entries and start over.
15



LEGACY MODE Overview
Module Type
After filling in Select File, enter the Module Type code of the module to be programmed. 
Module Type is a four-digit hexadecimal number. As defined earlier, the Master Module is 
always FFFF. Contact OEM supplier to obtain the codes for other modules.

Check Version Number
The Check Version Number check box is provided as an optional safety feature that 
prevents your module from receiving the wrong version of firmware. Unchecked (the 
default setting), the firmware file gets downloaded into the module without regard to the 
firmware version that it is replacing. Checking this box causes the Version Number text 
box to appear below the check box so that the version number can be checked.

Version Number
When Check Version Number is checked, the Downloader displays the Version Number 
text box. Enter a two-digit hexadecimal number for the version of the file to be 
downloaded. After Start is pressed, the Version Number entered is compared with the 
firmware version of the module. If the firmware version of the module is less than the 
value entered, the download will commence. If the firmware version of the module is 
equal to or greater than the entered value, the download will be prevented.

Module Type Status
At first connection to the Master Module, the Module Type Status control remains blank. 
After Start is pressed, the Downloader opens the selected Module Type and retrieves the 
status codes for all modules of that type, and displays all 16 harness codes for the given 
Module Type along with the status for each one. After the download completes, the 
Downloader updates the status codes and presents a message box to announce success 
or failure of the download. While the message box is displayed, the opportunity to review 
the updated status codes is possible before pressing OK, which then closes the 
connection and returns to the Main window.

Items in the Module Type Status control appear in the form:

Harness Code <HC> = <Status>

where HC is a two-digit decimal harness code (00 - 15).

Status can be one of:

• Not found – No module of given Module Type was found at this harness code.

• OK – Module Version matched, no need to download program.

• Needs program – Module Version is out of date.

• Failed program – Last attempted download failed.

• Passed – Download succeeded.
16



LEGACY MODEOverview
For example, before the download:

      Harness Code 00 = OK.

      Harness Code 01 = Not found.

      Harness Code 02 = Not found.

      Harness Code 03 = Not found.

      Harness Code 04 = Not found.

      Harness Code 05 = OK.

      Harness Code 06 = Needs program.

      Harness Code 07 = Not found.

      Harness Code 08 = Not found.

      Harness Code 09 = Not found.

      Harness Code 10 = Not found.

      Harness Code 11 = Not found.

      Harness Code 12 = Not found.

      Harness Code 13 = Not found.

      Harness Code 14 = Needs program.

      Harness Code 15 = Needs program.

After the download:

      Harness Code 00 = OK.

      Harness Code 01 = Not found.

      Harness Code 02 = Not found.

      Harness Code 03 = Not found.

      Harness Code 04 = Not found.

      Harness Code 05 = OK.

      Harness Code 06 = Passed.

      Harness Code 07 = Not found.

      Harness Code 08 = Not found.

      Harness Code 09 = Not found.

      Harness Code 10 = Not found.

      Harness Code 11 = Not found.

      Harness Code 12 = Not found.

      Harness Code 13 = Not found.

      Harness Code 14 = Passed.

      Harness Code 15 = Passed.
17



FINAL NOTES End of Download
Final Notes

END OF DOWNLOAD
When the download ends, the Downloader updates the status information for the listed 
modules and then displays a message box that indicates whether the download was 
completed. The prompt will also ask whether or not to remain connected. Choosing Yes 
will cause the Downloader to hold the connection open, refresh the modules list once 
again, and then allows for further downloads. Choosing No will cause the Downloader to 
close the connection and return to the Main window.

In Legacy Mode, the Downloader cannot remain connected after a download, so the 
Downloader does not present that option. After a Legacy Mode download, the message 
box merely informs of success or failure. Press OK and the Downloader will disconnect 
from the Master Module and return to the Main window.

If using a modem, the Downloader also commands the modem to disconnect after it 
closes the connection to the Master Module.

EXITING THE APPLICATION
Use the Exit option from the File menu, the Close button in the upper right corner of the 
window or the keyboard shortcut, Ctrl+Q, to exit the Downloader. If a download is in 
progress, the Downloader will prompt you to confirm whether you wish to exit. However, 
understand that interrupting a download abandons the open modules, leaving them with 
invalid firmware. Any modules that are open for download at the time the application exits 
shall require a completed download later, before they can enter service.

Company Information

ADDRESS
HED (Hydro Electronic Devices, Inc.)
2120 Constitution Ave.
Hartford, WI 53207

WEB SITE
www.hedonline.com
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